# Table of Contents

INTRODUCTION .................................................................................................................. 3  
AUTHOR™ BASICS .......................................................................................................... 4  
Running a Lesson ........................................................................................................ ... 6  

**STEP 1: CREATING A LESSON FROM THE TEMPLATE** .............................................. 7  
Creating a New Lesson .................................................................................................. 9  

**STEP 2: CHANGING THE TEMPLATE TO MEET YOUR NEEDS** .............................. 11  
Removing Menu Options ............................................................................................... 12  
Change a Menu Option .................................................................................................. 14  
Renaming Options ........................................................................................................... 16  
Menu Buttons ................................................................................................................... 19  
Sub-Menu Buttons .......................................................................................................... 22  
Test the Lesson ................................................................................................................ 28  
Customising the introduction screen and Main Menu .................................................. 30  

**STEP 3: ENTERING CONTENT** .................................................................................. 34  
Enter the Learning Objectives ....................................................................................... 35  
Enter the Information Element .................................................................................... 37  
Copy Element .................................................................................................................. 40  
Adding a Premade Element ............................................................................................ 44  
Inserting a Premade Multiple Choice Question Element ............................................ 54  
Test the Lesson ................................................................................................................ 55  
Add your Content ............................................................................................................ 55
INTRODUCTION

AUTHOR™ is an extremely flexible, non-programming tool for creating, delivering and managing eLearning. The full tutorial will take you through creating a lesson from first principles. This tutorial will show you how to create eLearning quickly and simply using the Lesson and Element templates.

Aim  The aim of this Tutorial is to guide you through the process of creating a lesson using AUTHOR™.

Lesson  The lesson presents information in a simple menu structure using text, graphics and voice-over. This is not the only style of an eLearning/multimedia module that you can create using AUTHOR™. It is simply an example of a common style of module. As this module presents information and our emphasis is on education and training we use the word Lesson to describe any module created with AUTHOR™. The user of your Lesson will be described as a Trainee.

When you finish the tutorial you will have completed all the major steps involved in constructing an AUTHOR™ Lesson using the Tutorial Lesson template.
AUTHOR™ BASICS

It’s best to start with an explanation of the basic components of AUTHOR™.

AUTHOR™ is mainly used for training, so each module of eLearning you create using AUTHOR™ is called a Lesson.

A Lesson will have a structure, either a simple Sequential structure (like PowerPoint), a Random sequential structure (used for testing) or a Menu structure (used for the majority of eLearning).

A Menu lesson may include Sub-menus, and sequential and random structures.

No matter which lesson structure is chosen, it will consist of basic building blocks called Elements.
An **Element** has 3 sections:
- **Information** (where you present information to the trainee),
- **Interaction** (where you define how the trainee interacts with the information), and
- **Response** (where the trainee receives feedback on their interaction).

Each Section will usually contain a list of **Actions**. Common Actions are displaying text, playing Audio/Video, pausing the lesson, and placing various interactive objects such as buttons.

Inserting or editing an Action will display a dialog box that lets you set or change the properties of that Action.
The following diagram shows the process of editing AUTHOR™ content.

**RUNNING A LESSON**

You use the AUTHOR™ Development system to create your lesson and produce a HTML file to test and deliver your lesson.

When an AUTHOR™ lesson runs, it will start at the Lesson Introduction and will run through all of the Actions you have created. When it reaches a menu it will wait for the trainee to choose an option. In a sequential option, it will start at the beginning and display each of the Elements in that option, one after another. When it reaches the end of the option, it will automatically return to the menu for the trainee to make another choice.

It is important that you realise that AUTHOR™ is simply following your instructions. The most common mistake is to insert an Action into the incorrect place in a list. Remember that AUTHOR™ will start from the top of the list and execute the Actions in order – so be careful to place your Actions in the correct sequence.
STEP 1: CREATING A LESSON FROM THE TEMPLATE

Objective
To create a new lesson “File > New (Template)”.  

Overview
You will create a new lesson from a template. The Tutorial Lesson template provides a pre-defined lesson based on a main menu. The template lesson contains customised backgrounds, menus, buttons text and graphic layouts.

A template lesson is a standard AUTHOR™ lesson with a .LET extension, so you may edit existing templates or create new ones as you require.

Concepts
You create a new Lesson in the same way that you create a new document in a word processor, by choosing File > New.

Layers
When you display text, images and video on the screen, some will appear on top of others. This will usually be determined by the order in which you display them, but objects that are added to the Background and Foreground layers will remain on the screen, while any other content will be removed as the lesson moves from Element to Element.

Background
The background is used to keep information actions displayed over several screens (or even the entire lesson). The most common of these are background screens, titles, and subtitles. Adding an object to the background screen will keep it there for the rest of the option, unless you choose to make it invisible.

Foreground
The foreground is used to keep interactive actions displayed over several screens. Like the background, objects on the foreground will remain there until you choose to make them invisible. The foreground is most commonly used for lesson navigation buttons that we’ll cover in more detail later in the tutorial).

Element
Your lesson content will be made up of Elements - the basic building block of an AUTHOR™ lesson. Each Element may display various objects such as text, images, audio and video, allow the trainee to interact with buttons or input fields and then
respond to trainee input with more text, images etc.

At the end of an element, all the objects on the element layer will be cleared. However, anything on the foreground and background will remain.

**AUTHOR™ Development Dialog**

Once you add an object to the Foreground, it cannot be removed, and objects on the background are only ever removed at the end of the menu option. However, you can effectively remove them by making them invisible.

**Interface**  
**AUTHOR™** uses the whole screen to display your development. Dialog boxes, the script window, and library window will float over the top of your work. This ensures that “What you see is what you get” and will immediately reflect any changes you make. Your starting point is the **AUTHOR™** Development dialog box. Here you create and view the structure of your lesson, insert Elements and select lesson components for deletion or editing.

We will be referring to the **AUTHOR™** Development dialog often. Please examine the diagram above to familiarise yourself with the location of the Structure pane (which contains the Structure List), the Contents pane (Contents List), the Lesson type icon, the Structure buttons and the Element buttons.

**Tasks**  
Create a new lesson from the Tutorial template.
CREATING A NEW LESSON

1. Select New from the File Menu, to create a new lesson.
   This will display the New lesson dialog.

2. Click on the Template radio button to allow you to select templates.

   There are templates designed for different screen sizes (resolution).

3. Select Tutorial Lesson Template.

4. Type in your lesson name (eLearning Graphics) and click OK.
This will display the **AUTHOR™** Development screen with the Tutorial Lesson Template loaded.

The Tutorial Lesson template has a main menu with 8 generic options plus options for a Summary, Learning Objectives, Navigation Help and Assessment. You will need to customise the menu to suit your lesson. In the case of our example script, its table of contents show that there are 4 main menu options. One of the main menu options (**Sourcing graphics**) is a sub-menu.

The menu options are:

- **Graphics**
  - **Sourcing graphics**
    - Drawing graphics
    - Digitising
    - Acquiring
  - **Editing Tools**
  - **File formats**
    - The Element Storage section contains premade elements for your lesson.
**STEP 2: CHANGING THE TEMPLATE TO MEET YOUR NEEDS**

**Objective**
To change the lesson structure to meet the requirements of the Tutorial script.

**Overview**
You will modify the AUTHOR™ Development to suit your script and enter names and captions for the main menu and Sub-menu options and buttons.

**Tasks**
- Remove four menu options, summary and the assessment.
- Change one menu option to a Sub-menu.
- Create the sequential options for the Sub-menu.
- Rename the lesson options and Sub-menu.
- Rename and arrange the main menu and Sub-menu buttons.
REMENOVING MENU OPTIONS

As the Lesson Template has more options than we require for our script, we need to delete some menu options.

5. Click on **Option 5** to select it. Right click on the selected **Option** to display the popup menu and select **Delete**.

Click **Yes** to delete the option.
6. Repeat the same procedure for Option 6 to Option 8, Summary and Assessment. Now the displayed structure should reflect the structure required for our lesson: 4 Options plus Learning Objectives and Navigation Help.
**CHANGE A MENU OPTION**

You may recall that the second menu option in the script is in fact a Sub-menu, leading to other options.

7. Option 2 needs to be changed to a Sub-menu rather than a simple sequence. Click on **Option 2** and click the **Add a Menu** button on the tool bar.

![Menu Options](image)

A dialogue will appear asking if you wish to change the **Sequence** to a **Menu**.

![Confirmation Dialog](image)

8. Choose **Yes** to replace this option.
9. Now select OK and the AUTHOR™ Development dialog will reflect the new Sub-menu structure.

Notice that the new options are represented by Question marks (?). An option may be turned into another Menu, a linear Sequence of elements or Random sequence of elements. In this case, each option will consist of a Sequence of elements.

We only require three new, so select Option 4 and delete it.

10. Click the first option in the new Sub-menu and click the Add a sequence button on the Toolbar.

Repeat this process until all the options have been changed into Sequences.

We now need to give meaningful names to the Menu options to make them more understandable.
**RENNING OPTIONS**

To rename the menu options we could right click on each option, choose **Rename** and type in the new text. However, it is quicker and more accurate to select the required text from the Script and Paste it directly (this reduces the possibility of introducing typing errors).

11. From the **View** menu, select the **Script file** option and the select **Open script**. A Select File dialog will appear.

![Select File Dialog](image)

12. The eLearning Graphics.doc file is available in the `Documents\Microcraft AUTHOR\LessonTemplates\TutorialGraphics_Template\Source Materials\Docs` folder. Navigate to this folder and select this file.
13. The Script file window will appear with the Tutorial script loaded. Move or resize the window so that the AUTHOR™ Development window is visible.

14. Scroll down the script text until the Table of Contents is visible.
15. Select Option 1 in the AUTHOR™ Development window.

16. Select the ‘Option 1’ option from the Menu Structure, right click on the option and select rename. Name the option “Graphics” (as indicated by the menu structure in the script) and press Enter to confirm.

17. Repeat the same procedure for the other options with the appropriate text. Close the Script window when you have finished.
Menu buttons are provided for the Main Menu with default captions that you will need to change. Also, as we have deleted some options, the extra buttons will need to be deleted and the rest repositioned.

18. Select the Menu icon in the structure pane, then click the Edit button on the tool bar.

19. When the Menu dialog appears the Preferences tab will be selected. Select the Interaction tab.

You can now see that the structure of menus (and elements) in the lesson consist of a dialog box with multiple tabs. Within each tab there will usually be a list of actions (such as displaying text or playing an audio file) or interactions (buttons, text input fields, checkboxes etc.).

The Interaction tab contains the list of each of the menu buttons. The name of each button will
refer to the Menu option associated with it.

As we only have four main menu options, we first need to remove the extra buttons in the Interaction list. To do this, select the extra buttons (Option 5, Option 6, and Assessment) one-by-one and press the Delete key on the keyboard, (or if you are familiar with selecting multiple items in lists, use the Ctrl key or Shift key with the mouse to highlight these buttons and then press the Delete key).

![Menu - Main Menu](image)

We will now have to alter the text within each of the menu buttons to reflect which option they will lead to.

Select and edit the first button, “Graphics”.

If you have correctly named your Options, changing the text of the buttons is easy. Simply click the Paste Option Text button and the text will be changed to the name of the Option which the button is linked to, then click OK to save the changes.

![Button](image)

Repeat this for each of the first four buttons (Graphics, Sourcing Graphics, Editing tools, File formats).
We will need to reposition the Objectives and Navigation buttons to reflect the image above.

Using either the Interaction action list or the work area, select the Objectives button on the screen, hold the control key (Ctrl), and then select the File Formats button.

Right click on the File Formats button, and from the popup menu, select “Align to left”.

Repeat the selection step for Navigation, and select “Align to right”.

20. Edit the first button: Graphics.

21. Select the BG Border tab.

   The appearance of a button in set in the BG Border tab.

   In the shape box you can select a variety of shapes for your button:

   The Fill menu sets the background fill of the button. It can be Transparent, Solid, Linear Gradient.

   The Start Colour menu sets the colour at the top/left of the gradient.

   The End Colour menu sets the colour at the bottom/right of the gradient.

   Angle sets where the gradient starts. 90 starts the gradient at the top. 0 starts the gradient at the left and you can set the value anywhere in between.

   Opacity sets how transparent the button is.

   You may change any of these characteristics if you wish or leave the existing selection.

22. Click OK twice to return to the lesson structure.
**SUB-MENU BUTTONS**

Various button configurations are available in the Tutorial Template Library. The Library contains pre-defined items or interactions - e.g. Headings, Yes/No buttons etc. You may add to the Library at any time and paste the saved objects into your lesson. This is particularly helpful when you need to create the same action (or a similar one) several times.

23. Select the Sub-menu icon in the structure pane, then click the **Edit** button.

![Sub-Menu Icon](image)

24. To make the **Navigation button** visible, select the **Menu** tab and then select the **Show/hide Action** from the toolbar.

![Navigation Button Visible](image)
We need to add a button to the Sub-menu to allow the trainee to return to the main menu. Buttons that allow the trainee to move around the lesson (e.g. Back, Next and Previous Menu) are called Navigation buttons. The Lesson Template has these Navigation buttons already defined in the Foreground layer of the lesson. The Previous Menu Navigation button already exists, but it is currently invisible. We need to make this button visible on the Menu screen.

The Visible dialog box shows the various actions and buttons that are defined in the Background, Foreground and Current Element/Option layers. You will need to select the appropriate tab to display the list for each of these layers.

Select Foreground on the dialog box that appears and place a tick opposite the “To Previous Menu” button.

Click OK to close the Visibility dialog.

25. We will need to add a title and sub-title in the Menu tab. These actions are available in the Tutorial Template Library. Click on the Library button (or press F4) to display the Library window. If the Graphics Tutorial Template Library is not selected, click on the Library name pull-down box and select the Graphics Tutorial Template Library.

26. Insert “Title” and “Sub-title” from the library by selecting them and hitting Paste into list.
27. Close the Library window.

28. Now modify the Title feature text action to say “Menu” and the Sub-title feature text action to display the appropriate title - “Sourcing Graphics”.

   Menu buttons must be set to point to the correct menu options and their captions need to be edited to represent these options.

29. When the menu preferences screen appears, select the Interaction tab.

30. Click the Library button to display the Library window.
The script specifies 3 options in the Sub-menu, so we will need to select 3 menu option buttons from the library.

31. Since there are three options in this Sub-menu, scroll down the list and select “Sub-menu Buttons” in the Library list and click on the “Paste from library” button.

This will paste the premade Sub-menu buttons into the Interaction list.
32. Close the Library window.

33. Make sure each of the buttons is pointing to the correct Option (check the Option pull-down).

You will now need to change the captions of the Sub-menu Interaction buttons. To edit button captions, select the button on the Interaction list, then click the edit button. You can then manually type the name of the option into the text box, or you can simply click the Paste Option Text button as before.
Repeat these steps for each Sub-Menu option. Click OK.
**TEST THE LESSON**

We can now test the lesson to see how the menu will appear to the trainee.

34. In the **AUTHOR™** Development dialog select the Tools menu and select the **Test Lesson** option.

The lesson will display in your default web browser. After the introductory screen the menu will appear. Selecting any of these buttons will display a screen. Clicking the **Next** button multiple times will allow you to move through the content of this screen and return to the menu (as we have yet to enter any content for each of the Sub-menu options, selecting any of these buttons will just reload the Sub-menu). When the menu displays, you will see that the option you selected will now display its "completed" version (in this case, the button text is greyed out).
35. When you have finished examining the menu select the Exit button from the menu to exit and return to AUTHORS™.

You may cancel testing at any time by closing the browser window.

If you encounter any problems during your test, go back into AUTHORS™ and check that you have not missed any steps and have performed each instruction correctly.
36. Select the **Menu** icon in the structure pane, then click the **Edit** button.

37. When the **Menu** dialog appears, select the **Intro** tab.

You can edit any of the actions in the list but, in this case, you will need to alter only the text and audio.
38. To change the module title, click on **Intro Title** (Feature text action) in the Intro list, then click the **Edit** button.

![Feature text dialog box](image)

This will display the **Feature text** dialog box.

*There are two types of text in AUTHOR. **Text** and **Feature Text**. Text is much the same as text in your word processor and you have full control over formatting. Feature Text only allows for one font and colour but provides various shapes that may be used in the background. Feature text is perfect for titles and labels, as well as using the shapes to highlight points of interest in the elearning.*

39. Type the new title into **Text field**. (We could paste this from the script, but in this case just type in **eLearning Graphics**).

![Feature text dialog box](image)

40. Click on **OK** to close the **Feature text** dialog box and return to the **Intro** list on the Menu dialog. Now you need to change the audio. Select the **welcome** audio near the top of the list and click the **Edit** button.
41. When the Audio dialog displays, click on the Folder button (to the right of the Audio field) to select a new audio file.

Select a file called EG_Welcome.mp3 in your Documents\Microcraft AUTHOR\Development\eLearning Graphics\Source_Materials\Audio folder.
42. When you have selected the file, click **OK** to close the **Audio** dialog.
## Step 3: Entering Content

**Objective**  
To create the lesson content.

**Overview**  
The content in the lesson is divided into Elements. The type of Element may vary from simple information display to complex questions or interactions - depending on the requirements of your script. You will first enter the Learning Objectives. Then you will modify the Information element in the first option of the menu. Then use the Import Elements tool to create two question types – True/False and Multiple Choice question.

**Tasks**  
Enter the learning objectives  
Enter the Introductory text for menu option 1 into the Information element.  
Paste an element from the element storage.  
Import a True/False element.  
Enter the question text, audio and feedback.  
Test the question.  
Import a Multiple Choice element.  
Enter the question text, audio and feedback.  
Test the question.
**ENTER THE LEARNING OBJECTIVES**

43. To change the Learning Objectives, first select **Learning Objectives** from the left pane of the **AUTHOR™ Development** dialog and then select the **Learning Objectives** element in the right-hand pane. Click the **Edit** button to edit.

44. This will display an **Information element**.

---

**Title**

By the end of this module, you will be able to:

- Insert learning objective here.
- Insert learning objective here.
- Insert learning objective here.
- Insert learning objective here.
- Insert learning objective here.
45. Edit the Text actions in the Learning Objectives screen to match the script the same way you modified the text in the introduction.

46. Remove any leftover text actions and the corresponding wait for timer actions by selecting them in the list and pressing the “Del” key.

47. Reposition and reformat the displayed text if you wish.

48. Replace the audio file with EG_LearnObj.mp3 which is available in your Documents\Microcraft AUTHOR\Development\eLearning Graphics\Source_Materials\Audio folder.

49. Modify Wait for Timer actions in the list to use correct interval values. The interval values are 3, 5.5, and 9 seconds.

50. Click OK to return to the AUTHOR™ Development dialog.
You will have noticed that when you select an option in the left-hand structure pane, a blue information element appears in the right-hand content pane. This Information element is provided by the Tutorial Lesson template and is designed to be the first element in each option.

Within this element is a graphic, 5 paragraphs of text, an audio file and navigation buttons. The paragraphs of text are designed to appear in sequence with the voice-over audio.

We will enter new text content, change the graphic, change the audio and alter the timing of the text display to reflect the new audio.

Click on the Information element (First Information) and click the Edit button.
51. To change the option heading, click on the "Title" Feature text action and then select the Edit button.

52. Open the script and paste in the appropriate option title (Graphics) then select Add to Background as we want this Title to appear on all subsequent screens of this option. Click OK to close the Feature text dialog and return to the action list.

53. Edit Sub-title Feature text action and enter an appropriate topic heading (such as "Introduction") for this section of the lesson. We do not add the Sub-title to the background as the Sub-title varies for different elements within a menu option.

54. Enter new text content from the script by editing the appropriate Feature text actions. Paste the new text using the Script file as you have done before. Delete any Feature text actions and related Pause actions that you don’t need.

55. Resize and reorganise the Feature text displayed on the screen, if needed.

56. To change the displayed graphic, select the Image action “Image” from the Information list and click on the Edit button.
57. This will display the **Image** dialog box.

![Image dialog box](image.png)

58. Select the **Folder button** to display the **Select File** dialog to select a graphic. Use the graphic file `Option_01_01.jpg` in your `Documents\Microcraft AUTHOR\Development\eLearning Graphics\Source_Materials\Graphics` folder.

59. If necessary, position the new graphic by entering appropriate X and Y coordinates in the position fields or by dragging the image on the screen.

60. Click **OK** to close the **Image dialog** and return to the **Information element**.

61. You may want to resize and reorganise the feature text displayed on the screen, if needed.

62. Change the **audio** action to use the audio file `EG_Screen01.mp3` (in your `Documents\Author15\Development\eLearning Graphics\Source_Materials\Audio` folder).

63. Implement voice-over timing for **Feature text** items in the action list by changing the **Wait for** actions to match the points in the audio file. You may use the audio dialog to view the time where various audio events occur.

64. Test the lesson now by selecting **Tools** menu and then **Test lesson**, or simply press **F6**.

65. If you encounter any problems during your test go back into **AUTHOR™** and check that you have done everything correctly.

You may cancel testing at any time by closing the browser window.
You may have noticed that there is no default information element in the Sub-menu options (as shown below).

To insert the content, we need to copy and paste the first information element in a different menu option (e.g. Graphics > First Information).
67. To copy and paste an information element, select the element first and then click on the Edit menu and select Copy.

68. Now, select the item in the right hand pane above which you would like to paste the copied element into (Drawing Graphics > End) and then click on the Edit menu and select Paste.
69. The copied element will be inserted. Now, you can edit the contents of the element to suit your needs. You may want to rename the element (right click on the element and select “Rename”). Use EG_Screen03.mp3 as the audio for this element. Remember, you need to select the element and then click the Edit icon to edit the element.

70. Now, insert a First Information element into the “Digitising” Option.

71. Edit the Information element you have just inserted into the “Digitising” Sub-menu option to display the appropriate text from the script.

72. Use tut_ulead3d_l.jpg from the Documents\Microcraft AUTHOR\Development\eLearning Graphics\Source_Materials\Graphics folder as the graphic and EG_Screen05.mp3 from the Documents\Author15\Development\eLearning Graphics\Source_Materials\Audio folder as the audio for this element.
**ADDING A PREMADE ELEMENT**

You have been introduced to the **Tutorial Lesson Template**. The template provides a structure, navigation buttons, fonts, headings and an introductory element for each menu option. Inside each **Lesson Template** is an associated **Element Storage** which contains a number of ready-made Information and Question elements. We could build a True/False element from scratch. However, it is often faster to use elements from the **Element Storage**.

We are going to add a **Question** element after the **Information** element in the “**Graphics**” Option. Select where you want to insert an element in the displayed elements, (in this case select the **End** item from the “**Graphics**” option). This means that any element inserted will appear before the **End** item and after **Option 1 - Element1**.

73. The **Element Storage** is usually open by default, and can be found in the lower right hand side of the element pane. If you cannot see the **Element Storage**, you can open it by selecting **Element Storage** under the **View** menu, or by pressing **F4**.

![Element Storage Screenshot](image-url)
74. You should now see the “Element Storage” panel beneath the Element pane.

75. Scroll down the list until you find True/False Question, then double click on it to insert the True/False question into the option.

76. To edit the True/False element, select the element in the right content pane and then click on the Edit button.
77. This will display the following dialog.

78. Now we will insert a blank **Sub-title** (available in the library) to be displayed in the upper right corner of the screen. Click the **Library** button (or press **F4**) to display the Library.

79. Insert the blank **Sub-title** from the **Tutorial Template Library**.
80. Now select the **Sub-title** (you may need to scroll the list upwards) and edit it as before, changing the text to **Self-assessment**.

81. When you return to the Information list, change the audio file by selecting the **Blankaudio** action and clicking **Edit**.

82. Change the Audio file to **EG_Q1.mp3**

83. You can modify the text by first selecting the **Text body paragraph** from the **True/False** Information list and then clicking on the **Edit** button. Use your script to Paste the required text. Reposition the text on the screen, as preferred.

84. To change the correct answer, click on the **Interaction** tab and then select the appropriate answer. Reposition the buttons as required. By checking the script, we can see that the correct answer is "True".
85. To modify the feedback text and audio, click on the **Response** tab.

![Response tab](image)

86. This will display three conditions (**IF Answer = Next**, **CORRECT** and **INCORRECT**).

Select **CORRECT** and then click on the **Edit** button.

87. The **Response add/edit** dialog box will be shown.

![Response dialog box](image)
88. Click on the Feedback tab to display the actions for correct feedback. Now you can change the displayed text and add the audio for the correct feedback. Use EG_Q1C.mp3.

89. You will notice that you have two instruction texts overwriting each other at the bottom of the screen. You will need to hide the original instruction text by selecting the top of the list and then the Show/Hide action and making the box next to the Instruction text blank.
90. Click **OK** to return to **Response** tab.

91. You can now change the text and audio for the incorrect feedback in the similar manner.

92. Add an Audio for the incorrect feedback (**INCORRECT**). Use **EG_Q1IC.mp3**.

93. Click on **OK** to close the True/False element and return to the **AUTHOR™** Development dialog.

94. As before, use the **Element Storage** to import a **Click on Graphic** element into the **Acquiring** option under the **Sourcing Graphics** Sub-menu.

95. Edit the **Click on graphic** element in the **Acquiring** option.

96. We now need to modify the response for this **Hot spot** so that when a trainee clicks on the **Hot spot**, it will open the **hyperlink**. To do this, first click on the **Response** tab.

97. Click on the **Add** button to add a new response. This will display **Response add/edit** dialog.

98. Now, set up a condition as displayed below by clicking on the drop down lists and selecting the appropriate values.
The condition "IF ANSWER = Door" means that this condition is True if the trainee clicks on the first hot spot button ("Door").

We will need to setup the feedback for this response. In this case, we need to open a website. Click on the Feedback tab to display the Feedback list.
99. We will add a Web Action to this element. Click the **Web Action** on the **action toolbar**.

100. To display a web page. We will need to enter the URL address into **AUTHOR™**. Click the Web Address icon and enter **http://www.microcraft.com.au** then click "**OK**". Resize the web page, if needed, by using the mouse to drag out the corners of the web page.

101. We also need to add a **Wait for User** pause after the **Web Action** in the actions list. To add a **Wait for User**, click **Add a Pause** on the **action toolbar** as shown below. Leave the first option selected then click **OK**.

In this case we only need to **Wait for User**. However, if you need to use **Wait for Timer** actions to synchronise **voice-over**, the same process is followed, selecting the **Wait for Timer** option instead.
102. We need to adjust one more setting before closing the Response add/edit dialog box. Click on the Lesson flow tab.

By default, once a response has been selected, the lesson flow will continue to the next element. However, in this instance, we don’t want to move to the next element as the trainee may not have completed the element yet. To do this, select the “Repeat element” radio button and then under Feedback select “Remove” option as shown below.

103. Click OK to close the Response add/edit dialog.
**INSERTING A PREMADE MULTIPLE CHOICE QUESTION ELEMENT**

104. You can insert a premade Multiple choice ("Multi choice single answer") element just the same way as a True/False element. Insert a Multiple Choice question after the True/False question in the “Graphics” menu option.

105. To edit the Multiple choice element, select the element in the right content pane and then click on the Edit button.

106. This will bring up the following dialog.

![Multiple Choice Dialog](image)

107. You now need to edit the Sub-title as we did in the True/False question to say “Self-assessment”.

108. You can now edit the Question text and the Question options text just like before.

The audio files are EG_Q2.mp3 (question audio), EG_Q2C.mp3 (correct response), EG_Q2IC1.mp3 (1st incorrect response) and EG_Q2IC2.mp3 (second incorrect response) the graphic is EG_Q2.jpg.

109. To enter the correct answer, click on the Interaction tab and then click on the appropriate check box under Correct answer(s).

110. To change the feedbacks, click on the Response Tab.

111. You will see four conditions; CORRECT, INCORRECT, and IF SelectedValue = Next (Next button). You can change the feedbacks for these conditions by selecting them one by one and clicking on the Edit button as you have done previously. You may need to use a Show/Hide action to hide the original instruction text as detailed in Step 89.

112. Click OK to return to the AUTHORTM Development dialog.
**TEST THE LESSON**

113. Now test your questions.

---

**ADD YOUR CONTENT**

Congratulations! You have now completed the Tutorial. The script contains more information and questions that you may implement. Try out some of the other ready-made elements available from the Element Storage List.

114. Now start adding your content into the remaining parts of the lesson.